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* How to read controller model code RCP2-CF Specifications
' A ' [RCP2-C/CG] Specification Item Built-in Cutoff Relay Type
Model RCP2-CF-**Note 2)
Quality and Innovation RCP2-C-SAS5- !.' PM-0-P-K Number of Controlled Axes 1-axis / Unit
y o
<Series> <Absolute Battery Mounting Bracket> Power-supply Voltage 24VDC+10%
Blank : No bracket Power Current Max. 6A
RC P2 -CIC GIC F <Type of Safety Circuit> K  With bracket Rush Current 8A
Cyp' Built-in gutoff Relay ) Control Method Weak field-magnet vector control
CG: External Cutoff Relay <IBr;2rl:tkapﬁlgﬁtfst;:]ﬁ?;;é;ormab Encoder Resolution 800Pulse / rev (quad edge evaluation)
IOk:10] F H t St G H d 'f e . Positioning Command Position number indication
P : PNP (Source Type)
w I rs e p u I e FI th Ed Itl O n <Actuator Type> - Number of Positions Standard 16 points, Max. 64 points
DBz ?XSScrgVéfgger Type !‘\;)SAType RXGD %’Eger Type <Power-supply Voltage> Backup Memor Save position number data and parameters to non-volatile memory
oA oneR A e g 0:24VDC P Y Serial EEPROM 100,000 times rewritable
Thank you for purchasing our product. .SA7 -SA7R RSA .RMGS .GR3SS PIO Dedicated 10-point input / 10-point output selectable from 6 patterns
Make sure to read the Safety Guide and detailed Instruction Manual as well as this First Step Guide to ensure correct use. .8S -SSR .RSGS  -RMGD .GR3SM <}L\’Al\(/)lt9lr31l;}lspee;/lotor LED Indication RDY (GN) - RUN (GN) - ALM (RD)
This Instruction Manual is original. ‘SM  SMR -RSGD ‘GR3LS Communication RS485 1ch (terminated externally)
-GR3LM :
Warning : Read the instruction manual carefully and follow the instruction manual when handling this equipment. Belt Slider Type Splash-Proof Rod Type Rotary Type Encoder Type> Electromagnetic Brake Compulsory |+ ie switch on front side of housing
Please downloaded the user's manual from our website. BA6  -BABU RSW RTB |+ Incremental Release
You can download it free of change. User registration is required for first time users. BA7 BATU RSW RTC A Absolute Actuator Cable : 20m or less
URL:www.iai-robot.co.jp/data_dI/CAD_MANUAL/ Cable Length PIO Cable - 5m or loss
Keep a printout of the introduction manual near the equipment in which this product is installed so that - .
it can be checked at all times, or display it on your computer, tablet terminal, etc. so that you can [RCP2-CF] Insulation Strength 500vDC 10MQ
check it immediately. Surrounding air o
If you need a bound copy of the instruction manual, order it from the nearest sales office listed in the R C P 2 - C F - R F A - I_' P M - 0 - P temperature 0to 40°C
First Step Guide or at the end of the instruction manual. It will be provided for a fee. <Series> | Surrounding humidity |85%RH or less (non-condensing)
« Using or copying all or part of this Instruction Manual without permission is prohibited. <Input and Output Signal Format> Surrounding [Refer to Installation Environment section]
. . <Type of Safety Circuit> Blank : NPN (Sink Type) environment
* The company names, names of products and trademarks of each company shown in the sentences are registered it . . . -
trademarks CF : Built-in Cutoff Relay High Output Type P : PNP (Source Type) Environment |Surrounding storage 10 to 65°C
: temperature -10to
<Power-supply Voltage> :
<A:|K.Uﬁtgf Tyze; s . 0:24VDC :urr%gtndmg storage |900,RH or less (non-condensing)
Product Check igh Speed Ball Screw Type umidity
:ng L <MotorType> Vibration resistance XYZ Each direction 10 to 57Hz Pulsating amplitude 0.035mm (continuous) 0.075mm
i i i ; [P ) ; o PM : Pulse Motor (intermittent)
This product is comprised of the following parts if it is of standard configuration. f'é%fh’“s‘ Rod Type Cooling Method Forced air-cooling
If you find any fault in the contained model or any missing parts, contact us or our distributor. REW ———————<Encoder Type> Protection Class 1P20
. . | : Incremental f
1. Parts (The option is excluded.) Water-Proof Type Weight . ' 300g or less
‘RCP2W-SA16 External Dimensions 35 W x 180H x 71.6Dmm
No. Part Name Model P—
Note 2 indicates the actuator type.
1 Controller Main Body [Refer to “How to read the model plate”, “How to . S f t
read controller model code’] asic specirications /\ Note : Position data and parameters are written to EEPROM.
Accessories Characteristics The limitation for the reload is about 100,000 times. Take the greatest care.
2 1/0 Flat Cable CB-RAC-PIO*** (*** indicates the cable length. . . - " .
- - ( gth.) 1) This product is a position controller that enables to position at 16 points for the standard type and 64
3 First Step Guide ME0252 points for the maximum. Number of the positioning points depends on the PIO patterns (can be selected External Dimension
4 Safety Guide M0194 from 6 kinds of control method) that is selectable with the parameters.
2 Teaching Tool 2) The zone output boarder value_can be set for each positioning point. o ) [RCP2-C/CG Standard Type] [RCP2-C/CG Absolute Specifications
- leaching 100 3) The acceleration and deceleration values can be set separately for each positioning point. (with Battery Mounting Bracket)]
The PC software or teaching pendant is necessary to perform setup operations such as 4) The transfer speed in test run adjustment can be controlled to ensure safety. v 9
position and parameter settings through teaching or other means. 5) Power saving mode can be selected with a parameter for a use that contains a long time standby. 95 62.0 2.0 69.7
Prepare either PC software or teaching pendant. RCP2-C/CG Specifications 68.1 © 35.0
No. Part Name Model Specification Item Built-in Cutoff Relay Type [ External Cutoff Relay Type 1 é ~ 95
1 | PC Software RCM-101-MW Model RCP2-C-r(Note |RCP2-Ca-+tete id B
2 PC Software RCM-101-USB Number of Controlled Axes 1-axis / Unit 5 o
- Power-supply Voltage 24VDC+10% E o
3 Teaching pendant CON-T Power Current Max. 2A @ o |
4 Teaching pendant CON-T/TG Rush Current 8A 2 3 -
5 Teaching pendant RCM-T Control Method Weak field-magnet vector control g = H 0 jc:v
. N N Encoder Resoluti 800Pulse / d ed luati - = | ©
6 Teaching pendant (with deadman switch) RCM-TD neoder Resouton TUSe /ey (q.ua. cTe Bvala hon) 5 &g I]
- — - Positioning Command Position number indication ° |5
7 Simplified Teaching Pendant RCM-E Number of Positions Standard 16 points, Max. 64 points = §
8 Data Setter RCM-P Backup Memo Save position number data and parameters to non-volatile memory 0 o — —
e - - - —— P i Serial EEPROM 100,000 times rewritable 2 S
Fixed type touch panel display (RCM-PM-01) which enables data input, change and monitoring is also 50 Dedicated 100t nbut7 10000t outout selecabie from 6 patt - 2
prepared. Please note only a few parameters can be set on the display. — cdicatec 10-polnt Inpu -Point outpul selectable from 5 patlems -
LED Indication RDY (GN) - RUN (GN) - ALM (RD) ]
* Instruction manuals related to this product Communication RS485 1ch (terminated externally) —
No. Name Manual No. Eléalztargrenagnetlc Brake Compulsory Toggle switch on front side of housing $
1 RCP2-C/CG/CF Controller Instruction Manual MEO0170 Aciuator Cable - 20m or loss
2 | PC Software RCM-101-MW/RCM-101-USB MEO0155 Cable Length PIO Cable - 5m or 165s o
- - [RCP2-C/CG Absolute Specifications [RCP2-CF]
3 Teaching pendant CON-T/TG MEO0178 Insulation Strength 500VDC 10MQ . .
- — (with No Battery Mounting Bracket)]
4 Teaching pendant RCM-T/TD MEO0173 tsu"oun‘:'”g air 0 to 40°C
——— - emperature
5 Simplified Teaching Pendant RCM-E MEO0174 Surrounding humidity [85%RH or less (non-condensing) 35.0 68.1 > | 76
6 | Data Setter RCM-P MEO0175 Surrounding . ) o |
- . t [Refer to Installation Environment section] —
7 | Touch Panel Indicator RCM-PM-01 ME0182 Evronment [onmen =i R
nvironment | Surrounding storage 10 to 65°C R
* How to read the model plate Smperere = S
Surrqgndlng storage 90%RH or less (non-condensing) £ E
p - humidity o °
IA I Corporation Vibrati ist XYZ Each direction 10 to 57Hz Pulsating amplitude 0.035mm (continuous) 0.075mm ) N °
Model —————— B vodel sk xxkkxxx N ( E fbration resistance (intermittent) Q T
S : | N b — ! SERNO. *%%kkkkkk [H us v T (o))
erial Number Ion&u(m 8%§¢V*9h0333H *A P20 Cooling Method Natural air-cooling Q2 [ﬂ ﬂ £ 2
Actiator Saxgh o MADE IN JAPAN Protection Class P20 S |2
CAUTION: Connelct the v}//i;ilng co{ireztly e;)rI]d Weight 300g or less g §
roperly, use specified cables ~
gr mpin iy30“c Cu wi?e. External Dimensions 35 W x 178.5H x 68.1Dmm g 5
\ PR © ;
Note 1 indicates the actuator type. o IS
&Note : Position data and parameters are written to EEPROM.
The limitation for the reload is about 100,000 times. Take the greatest care. ] 67.0 H -
o~
e}




Installation Environment

This product is capable for use in the environment of pollution degree 2! or equivalent.
*1 Pollution Degree 2: Environment that may cause non-conductive pollution or transient conductive
pollution by frost (IEC60664-1)

Do not use this product in the following environment
e Location where the surrounding air temperature exceeds the range of 0 to 40°C
Location where condensation occurs due to abrupt temperature changes
Location where relative humidity exceeds 85%RH
Location exposed to corrosive gases or combustible gases
Location exposed to significant amount of dust, salt or iron powder
Location subject to direct vibration or impact
Location exposed to direct sunlight
Location where the product may come in contact with water, oil or chemical droplets

When using the product in any of the locations specified below, provide a sufficient shield.
e Location subject to electrostatic noise
e Location where high electrical or magnetic field is present
e Location with the mains or power lines passing nearby

Installation and Noise Elimination

1. Noise Elimination Grounding

Attach the ground screw
terminal to the earth ground.

[Comorf,
(NS

Soft Copper Wire :
Connect to an ground cable with

— diameter 2.5 to 5.5 mm or more.

Earth Terminal

Class D grounding
(Formerly Class-III grounding :

Grounding resistance at 1000 or less) Do not share the ground wire with or connect

to other equipment. Ground each controller.

2. Precautions regarding wiring method
(1) Twist the wires for the 24VDC power unit.
(2) Separate signal lines and encoder cables from
high-power lines such as the power wire.

3. Noise Sources and Elimination

Carry out noise elimination measures for power devices on

the same power path and in the same equipment.

The following are examples of measures to eliminate noise

sources.

(1) AC solenoid valves, magnet switches and relays
[Measure] Install a surge absorber parallel with the coil.

(2) DC solenoid valves, magnet switches and relays
[Measure] Install a diode parallel with the coil. Use a

DC relay with a built-in diode.

4. Heat Radiation and Installation
Conduct design and manufacture in consideration of the control box size, controller layout and cooling in
such a way that the temperature around the controller will be 40°C or less.

50m or more l
I 95m

or more

Noise killer

g
ReIa[j @LR
coil y,JC

Relay coil

+24V [  ov

N

I 50m or more
Airflow

A :RCP2-C/CG 5mm or more
RCP2-CF  15mm or more

Wiring Layout

Host System <PLC>
S E— O

Teaching Pendant
= —
S oo

PIO Connector
Status Indicator LEDs

C% Flat Cable
& Accessories  [B
17| - h
r Set the servo on input and pause input to invalid
with the parameter when PLC is not to be used.
daé Cable Length : 2m
[of- Axis No. Setting Switch
- Port Switch
| Brake Release Switch

Personal Computer E Do not connect or remove

connectors while the power

is on except for the commu-

Actuator |nication port connector
(SI0). Connecting and

removing of SIO should be

performed after PORT

switch is turned off.

PC Software Otherwise, it may cause
<RCB-101-MW> malfunction.
Option

PERSONAL
COMPUTER

Power Supply and Emergency Stop Circuit (Example)

Following diagrams are an example of the circuits when the emergency stop switch on the teaching pendant
is utilized in the emergency stop circuit that you may construct.

¢ Drive Cutoff Relay Built-in Type : RCP2-C/CG/CF
» For the case one controller is used

Teaching pendant

EMG switch
@
+24V ﬁ%i‘%ﬁ ov
[ |
,,,,,,,,,,,,,,,,, N
RCP2-C/CGICF z
External EMG External
reset switch  EMG switch oo
: <o L |s1
—"" ~ >
, i
CR L [S2
i Motor Power Cutoff Relay
! Coil current 10mA or less
Emg- (Coil cur )
CR? : v
L | MPI : GND
L9> MPO }Molor Power Unit
o
N » | power supply
l > >
[cR
CR
[

» For the case multiple controllers are used

Teaching pendant

EMG switch
e
+24V ﬁ%ﬁ%ﬁ ov
L~ 1
N _
RCP2-C/CGICF —Y .
External EMG External
. . MAX 0.1A
reset rTgwnch EMS switch (30VDC)
! <® L st
CR : S2
>
! Motor Power Cutoff Relay
' lEMG- (Coil ct[J_rlrent 10mA or less)
CR™ i i
L ' GND
MPI )
9 MPO Motor Power Unit
K 24V
} oV }Control
N » | power supply
[ ==
——
? |81
7 S2
- ! EMG- Second Unit
CR E9> MPI
= [MPO
24V
F%E ov
—r— :
? |S1
7 S2
! nth Unit
5 EMG-
CR E9> MPI
> |MPO
24V
F%E ov

*1  When cutting off the motor driving power supply which is equivalent to the Safety Category 2,
connect 24V to EMG terminal, and connect a contactor contact point to MPI/MPO terminal like the
external-equipped type driving system cutoff relay.

*2 Connect the teaching pendant to the controller, and the controller automatically confirms the
connection.

*3  Apply 24V DC, 0.1A or more for the CR contact ratings.

&Note : The circuit diagrams above are an example of an emergency stop method that utilizes the
emergency stop switch.
Make sure to construct the optimized circuit that follows the specification of the emergency
stop of the whole system.

o Drive Cutoff Relay Externally Mounted Type : PCP2-C/CG/CF
o For the case one controller is used

Teaching pendant

EMG switch
+24V T ov

[
S
N NA
RCP2-C/CGICF —Y Ey
External EMG External
resetr%wnch EM& switch MAX 0 1A
i o) | s1 (30VDC)
— ~X >
, i
CR \ |82
4
‘> EMG-
L[ mPI .
CR® } Motor Power Unit
T
> ov Control
,792 1OV | power supply
[crl
CR
[t

o For the case multiple controllers are used

Teaching pendant

EMG switch
o
+24V <‘® ov
I
L~ 7
N NA
RCP2-C/CG/CF — iy
External EMG External
reset switch ~ EMG switch
| > \Bovbicy
! <@ | s1
—" I ”
, i
CR L |S2
{ | EMG-
‘> >
L | MPI .
CR o } Motor Power Unit
%> MPO
> (2)?/\/ } Control
,7%; ov. . [ powersupply
——
S1
7182
! Second Unit
g —> | EMG-
CR3T%> MPI
—> [ MPO
24V
F%E ov
—= :
S1
?|s2
%w> EMG nth Unit
CR? E%> MPI
—> [ MPO
24V
F%E ov
[crl
CR
[

*1  When cutting off the motor driving power supply which is equivalent to the Safety Category 2,
connect 24V to EMG terminal, and connect a contactor contact point to MPI/MPO terminal.

*2 Connect the teaching pendant to the controller, and the controller automatically confirms the
connection.

*3 Select the CR contact ratings from the motor power capacity.

&Note : The circuit diagrams above are an example of an emergency stop method that utilizes the
emergency stop switch.
Make sure to construct the optimized circuit that follows the specification of the emergency
stop of the whole system.




1/0 signals (PIO Type)

Function description for I/O Signals

NPN Specifications PNP Specifications
ov 24V 24V oV
Pin No. Pin No.
1A 1A
2A 2A
—>~—  3A ——  3A
—>—  4A ——1  4A
L~ 12A L  12A
1B 1B
2B Load 2B Load
3B — 3B
4B — 4B —
13B — 138 — H
1/O Flat cable
BL3
! Lower Bunch
' Upper Bunch
BR 1
1/0 signals
Setting of Parameter No. 25 (PIO Pattern selection)
Pin 0 1 2 3 4 5
Category| Cable Color
No. o/ Normal Standard Nun_\lber_ af Zone Teaching 4-Point
Type Type Pl Output Type Type
Points
Upper Bunch
1A +24V BR-1 P24
2A oV RD-1 N
3A OR-1 CSTR PC1 PC1 PC1 PC1 STO
4A YW-1 PC1 PC2 PC2 PC2 PC2 ST1
5A GN-1 PC2 PC4 PC4 PC4 PC4 ST2
6A BL-1 PC4 PC8 PC8 PC8 PC8 ST3
7A Inout PL-1 PC8 - PC16 - MODE -
8A P GY-1 - *STP PC32 *STP  |[*STP/JOG+ *STP
9A WT-1 — CSTR CSTR CSTR |CSTR/PWRT] —
10A BK-1 *STP HOME HOME HOME HOME -
11A BR-2 - SON *STP SON SON —
12A RD-2 - RES RES RES RES/JOG- RES
13A OR-2 (Not used)
Lower Bunch
1B YW-2 (Not used)
2B GN-2 (Not used)
3B BL-2 PM1 PM1 PM1 PM1 PM1 PEO
4B PL-2 PM2 PM2 PM2 PM2 PM2 PE1
5B GY-2 PM4 PM4 PM4 PM4 PM4 PE2
6B WT-2 PM8 PM8 PM8 PM8 PM8 PE3
7B BK-2 PEND ZONE1 PM16 ZONE1 MODES ZONE1
8B | Output BR-3 HEND MOVE PM32 ZONE2 MOVE -
9B RD-3 ZONE1 PEND PEND PEND |PEND/WEND| PEND
10B OR-3 *ALM HEND HEND HEND HEND HEND
11B YW-3 *EMGS
12B GN-3 - SRDY MOVE SRDY SRDY -
13B BL-3 - *ALM *ALM *ALM *ALM *ALM

&Note 1 (1) “¥”in codes above shows the signal of the active low.

(2) Do not connect the pins that are not in use (13A, 1B and 2B).
(3) The power supply lines for NPN type and PNP type are in common. It is not necessary to

turn around the power supply line even for PNP.
(4) *EMGS (emergency stop) that is allocated to the pin number 11B is valid for RCP2-C/CF.

Signal A .
Category Abbreviation Signal Name Summery of Functions
CSTR Start Start moving with rising edge
PC1to PC32 |Command Position Number |Input of the position number to move
*STP *Pause OFF to pause (decelerate and stop), ON to reboot
Start moving to the backward position with this signal ON for 4-point
. type
STO Move to Backward Position Signal input can be selected from edge and level (initial setting) with
the parameter
Start moving to the forward position with this signal ON for 4-point
- type
ST Move to Forward Position Signal input can be selected from edge and level (initial setting) with
the parameter
Start moving to the intermediate position 1 with this signal ON for
sT2 Move to Intermediate 4-point type
Position 1 Signal input can be selected from edge and level (initial setting) with
the parameter
Input Start moving to the intermediate position 2 with this signal ON for
ST3 Move to Intermediate 4-point type
Position 2 Signal input can be selected from edge and level (initial setting) with
the parameter
HOME Home return Start home-return operation with rising edge
MODE Operation Mode Mode select (ON : Teaching Mode, OFF : Normal Mode)
. N Current position is written to the position number selected from PC1
PWRT Current Position Write to PC8 after ON status being continued for more than 20msec
JOG+ B.Jog 4Move to Positive Move in positive direction while it is on.
irection
JOG- I—j.}og Move to Positive Move in negative direction while it is on.
irection
The servo remains ON while this signal is ON
SON Servo On OFF while this signal is OFF
RES Alarm Reset Alarm reset with rising edge
Output position number when positioning complete
PM1 to PM32 |Completion Position No. Turns off when next movement started
Used to check completion of positioning on PLC side
Turns on while in move, turns off in stop condition
MOVE While in Operation Turns off also when stopped by mis-pressing in pressing operation
and a pause
PEND Pasition Completion Turns on within posmpnlng banq in the movement to target position
Turns on when pressing operation complete
OFF when turning the power on, ON after home-return operation
HEND Home Return Completion complete
P For absolute type, it is ON until the home position is erased by an
alarm, etc. once the home return is complete.
MODES Current Operation Mode ON vx_/hlle in teaching selection with MODE signal, OFF in normal
condition
. Turns on when complete writing position data with the current
WEND Writing Complete position writing command (PWRT)
Output Output when the current position of the actuator is in the range set
ZONE1 Zone with the parameter after home-return operation complete
ZONE2 Used as a replacement for LS at intermediate point and a rough
measurement for pressing operation
PEO Backward Position Turns on when complete moving to backward position for 4-point
Complete type
PE1 Forward Position Complete [Turns on when complete moving to forward position for 4-point type
PE2 Intermediate Position 1 Turns on when complete moving to intermediate position 1 for
Complete 4-point type
PE2 Intermediate Position 2 Turns on when complete moving to intermediate position 2 for
Complete 4-point type
. Output when servo is on and ready for operation
SRDY Operation Ready Synchronized to LED “RUN” on the front of the external housing
*ALM *Alarm ON in normal condition, OFF when alarm is generated
Valid for RCP2-C/CF
*EMGS *Emergency Stop ON: in normal condition, OFF: in emergency stop
1/0 signals
Input section Output section
Input voltage 24VDC+10% Load voltage 24VDC
Input current 7mA/ 1 circuit Peak load electric current [20mA/ 1 point
Specification ON voltage : MIN. 18VDC
ON/OFF voltage
volag OFF :MAX.6VDC Residual Voltage 2V or less
Leakage Current MAX. 1mA/ 1 point
Controller Controller
.- 777777777?’24V
Internal .
Power Supply H
External
NPN | s < B | oo ou
C=0.1uF }\\ L External
I s Power Supply
- +24V
~ Co[\lrol\er ~ . ~
Controller torm
[ — A
N Internal
T Power Supply }\\K & Exemal
xternal 5600 3 YAF o PPl
PNP gotwer S‘upp\‘/ J Rz Re222 Each Output 2
+24V
Each Input| AN c=0 |uFI

Starting Procedures

When using this product for the first time, make sure to avoid mistakes and incorrect wiring by referring to
the procedure below.
* Please refer to “RCP2 Series ROBO Cylinder Instruction Manual” for details of each section.

Check of Packed Items

No—
Are there all the delivered items? Contacttielsalesishiop]

| | Yes
Installation and Wiring

Install and wire the actuator and the controller following the
instructions described in the Instruction Manual and this guide.

For Absolute Type
Connect the battery to the battery connector on the top side of the controller.

Point Check Item
e |s frame ground (FG) connected?
* Has the noise countermeasure been taken?

| Yes

l

Connect the PC or teaching pendant
and check the content of the alarm
Check Item to have the right treatment.
Is “ALM” in LED No—  For absolute type, an error code
display on the front “EE” Absolute Encoder Error
side of the panel off? (2) occurs in the first power-on
after wiring. Conduct the alarm reset.

Power Supply and Alarm Check
Connect a teaching tool such as .
PC and turn on the port switch to
supply power to the controller.

1 Yes
I If an alarm is generated,
Servo ON ) Check Item o—» connect the PC or teaching
Turn ON the servo motor with the personal Is the status display LED pendant and check the content

computer or teaching pendant operation. “RUN” turned on in green? of the alarm to have the right

treatment.

/\Note
The actuator may get slightly dropped by self-weight if | Yes
servo on and off is repeatedly performed at the same position.
Be careful not to pinch the hand or damage the work.

Check of Safety Circuit
Check that the emergency stop circuit (or motor drive-power
cutoff circuit) operates normally to turn off the servo.

| 1 Yes

Check the emergency stop circuit.

Absolute Reset (for absolute type)

Turn the servo on again and perform the home-return operation.

Absolute reset can be done by performing the home-return operation.

Once the home return is completed, home position gets established and memorized in the position data.

| .

Establishing the Target Position

Set the target position to the “Position” box on each position table.
Have a home-return operation first when the Direct Teach is performed.
When moving the actuator manually, set the Brake Release

Switch to BK RLS side for the brake equipped type before the

Direct Teach is performed.

!

Test Run Adjustment

(1) Make the safety speed invalid with using the PC software or the
teaching pendant and conduct an operation check.

(2) Select “Monitor Mode 2 Safety Speed Invalid / Permit PIO Start” in
MANU Operation Mode, then detach the PC or teaching pendant from
the controller.

(3) Set Mode Switch to AUTO side.

/\Note

To ensure safety, it is recommended

that safety speed be enabled during initial
movements.

If a vibration or an abnormal
noise is occurred, check if there
o isaproblem in the way to mount
the actuator, or the condition
of the actuator use is below the
rated values.

| Yes

Set-up for operation is completed. Perform the system operation adjustment.



1A1

Quality and Innovation

IA I Corporation

Head Office: 577-1 Obane Shimizu-KU Shizuoka City Shizuoka 424-0103, Japan
TEL +81-54-364-5105 FAX +81-54-364-2589
website: www.iai-robot.co.jp/

IA I America, Inc.

Head Office: 2690 W. 237th Street, Torrance, CA 90505
TEL (310) 891-6015 FAX (310) 891-0815
Chicago Office: 110 East State Parkway, Schaumburg, IL 60173
TEL(847) 908-1400 FAX (847) 908-1399
Atlanta Office: 1220 Kennestone Circle, Suite 108, Marietta, GA 30066
TEL (B78) 354-9470 FAX (678) 354-9471
website: www.intelligentactuator.com

IA |l Industrieroboter GmbH

Ober der Réth 4, D-65824 Schwalbach am Taunus, Germany
TEL 06196-88950 FAX 06196-889524
website: www.iai-automation.com

Technical Support available in Great Britain

LC Automation

control & safety

Duttons Way, Shadsworth Business Park, Blackbumn, Lancashire, BB1 2QR, United Kingdom
TEL 01254-685900
website: www.lcautomation.com

IA I (Shanghai) Co.,Ltd.

SHANGHAI JIAHUA BUSINESS CENTER A8-303, 808, Honggiao Rd. Shanghai 200030, China
TEL 021-6448-4753 FAX 021-6448-3992
website: www.iai-robot.com

IA I Robot (Thailand) Co.,Ltd.

825 PhairojKijja Tower 7th Floor, Debaratana RD., Bangna-Nuea, Bangna, Bangkok 10260, Thailand
TEL +66-2-361-4458 FAX +66-2-361-4456
website:www.iai-robot.co.th

Manual No.: ME0252-5A
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